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В системе Keysight ADS предлагаются два основных средства электромагнитной 
симуляции, которые встроены в данную среду для удобства разработчиков, решающих 
задачи электромагнитной симуляции своих проектов. В противоположность инструментам 
схемотехнической симуляции, электромагнитная симуляция выполняется на топологии.

В данном разделе проиллюстрирована последовательность действий по выполнению 
электромагнитной симуляции в системе ADS, если необходимость в такой симуляции 
возникает у разработчиков.

Практический пример 1: Микрополосковый полосовой 
фильтр

Создание схемы микрополоскового полосового фильтра
Создайте новую рабочую среду и выберите в качестве единиц измерения “mil”. Создайте 
новую схемную ячейку и разместите компоненты топологии полосового фильтра на 
связанных линиях, как показано ниже.

Рис. 43.
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Чтобы создать 5-звенный полосовой микрополосковый фильтр на связанных линиях, 
выполните следующие действия:

1. Вставьте компонент MCFIL (Звено фильтра на связанных линиях) из палитры 
библиотеки TLines-Microstrip (Линии передачи – Микрополосковые). 

2. Вставьте блок VAR и задайте переменные w1, w2, w3, s1, s2, s3 с указанными ниже 
значениями.

Рис. 44.

Измените значения у компонентов MCFIL, чтобы отразить величины данных переменных в 
W- и S-параметрах (обратите внимание, что единицы измерения соответствуют mil).

3. Задайте следующие длины (L) компонентов MCFIL:
 – первое и пятое звенья: 245 mil;
 – второе и четвертое звенья: 195 mil;
 – третье (среднее) звено: 237 mil.
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4. Задайте подложку микрополосковой линии (MSUB) со следующими значениями 
параметров:

 – H = 25 mil (Высота диэлектрика)
 – Er = 9.9 (Относительная диэлектрическая проницаемость)
 – Cond = 4.1E7 (Удельная электропроводность металла, в данном случае задается 

для золота)
 – T = 0.7 mil (Толщина металла)
 – TanD = 0.0009 (Тангенс угла потерь)

5. Вставьте на входе и выходе два компонента 50-омной нагрузки (Term) из палитры 
библиотеки Simulation- S_Param (Симуляция – S-параметры).

6. Поместите контроллер SP из палитры библиотеки Simulation-S_Param (Симуляция – 
S-параметры) и задайте его частоту 3 – 7 ГГц с шагом 0,01 ГГц.

7. Запустите симуляцию и просмотрите результаты. Они должны быть сходными с 
представленными на графике ниже. Если вам нужна помощь в создании графика в 
прямоугольной системе координат, загрузите раздел «Начало работы с системой 
проектирования Advanced Design System (ADS)».  
www.keysight.com/find/eesof-ads-rfmw-examples

Рис. 45.

http://www.keysight.com/find/eesof-ads-rfmw-examples
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Шаг 2 – Создание топологии из электрической схемы
Чтобы сгенерировать топологию из своей электрической схемы, из окна схемы перейдите 
в Layout > Generate/Update Layout (Топология > Сгенерировать/Обновить топологию). 
Нажмите OK.

Рис. 46.

Рис. 47.

После выполнения этого действия должна стать доступной показанная ниже топология, а 
вид топологии будет добавлен в список видов ниже имени ячейки. Это можно проверить в 
главном окне системы ADS.
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Шаг 3 – Настройка и запуск электромагнитной симуляции

Примечание:
Нет необходимости преобразовывать выводы в порты там, где не нужно смотреть 
результаты. Это сокращает размер набора данных симуляции.

Чтобы запустить электромагнитную симуляцию, мы должны правильно выполнить 
требуемые настройки. Ниже представлены основные действия для корректного запуска 
электромагнитной симуляции:

1. Подсоедините выводы (Pin) в топологии, которые затем будут определены в 
качестве портов (Port) в окне настройки электромагнитной симуляции.
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2. Нажмите кнопку настройки электромагнитной симуляции из панели инструментов 
электромагнитной симуляции на странице топологии (см. ниже).

2. Выберите подходящий инструмент симуляции – Momentum (Метод моментов) или 
FEM (Метод конечных элементов).

3. Задайте соответствующее определение подложки.
4. Задайте план свипирования частот симуляции.
5. Задайте характеристики сетки для проводников.
6. Создайте ЭМ модель и символ. Это опциональный шаг. Его можно пропустить, если 

нет необходимости выполнять совместную симуляцию электромагнитной модели 
топологии и схемы, т. е. объединять дискретные компоненты с топологией (эта 
функция поясняется в тексте ниже).

Начнем настройку электромагнитной симуляции в соответствии с данным выше 
описанием:

1. Подсоедините выводы к входу и выходу структуры фильтра.

Рис. 48.

Рис. 49.

a. Появится показанное ниже окно настройки электромагнитной симуляции. 
Вы увидите значок , который сигнализирует о том, что некоторые 
составляющие настройки отсутствуют. При удерживании указателя мыши поверх 
предупреждающего значка  будет выдано пояснение, касающееся подложки, 
так как мы еще не определили ее.
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b. Нажмите на опцию Substrate (Подложка), нажмите New (Новый) и затем нажмите 
OK для подтверждения создания подложки из алюмооксидной керамики на 
основе шаблона Alumina 25 mil. Мы можем изменить характеристики подложки в 
соответствии со своими задачами.

Рис. 50.

Рис. 51.
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c.  После нажатия OK откроется редактор подложки, как показано ниже. Выберите 
диэлектрик Alumina (Алюмооксидная керамика) и нажмите кнопку “….”, отмеченную 
с помощью курсора мыши на снимке экрана ниже:

Рис. 52.
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e.  Нажмите вкладку Conductors (Проводники), перейдите к Add from Database 
(Добавить из базы данных), выберите из списка Gold (Золото) и нажмите OK.

f. После того, как вы закончите задание характеристик диэлектрика и проводников, 
нажмите ОК. В главном окне задания характеристик подложки нажмите мышью 
“cond” (проводник) в графической части окна, выберите Gold (Золото) из списка 
материалов и задайте толщину равной 0.7 mil.

d. Во всплывающем окне измените характеристики алюмооксидной керамики 
(Alumina) следующим образом: Er = 9.9 и TanD = 0.0009, аналогично значениям, 
заданным нами при создании электрической схемы.

Рис. 53.

Рис. 54.
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Примечание:
Для проводника с конечной толщиной (Thick conductor) параметр “cond” 
(проводник) задается как Sheet (плоский). Вы также можете выбрать “Intrude into 
substrate” (Внедрить в подложку) или “Expand the substrate” (Утолщить подложку). 
Если проводник задан как Sheet (плоский), то нам необходимо использовать 
дополнительное разбиение сетки в области краев (опция Edge Mesh) согласно 
описанному ниже в п. 5. Если мы задаем его как проводник с конечной толщиной 
(Thick conductor), то опцию дополнительного разбиения сетки Edge Mesh можно не 
включать.

Примечание:
Нажав правой кнопкой мыши на графическое изображение в окне редактора 
подложки, можно добавлять дополнительные диэлектрические слои, переходные 
отверстия и пр.

g. После завершения задания параметров подложки нажмите Save (Сохранить) и 
закройте окно редактора подложки.

Рис. 55.

Рис. 56.
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h. Теперь в окне настройки электромагнитной симуляции не должно наблюдаться 
никаких предупреждающих значков  в области подложки. Если вы все еще 
видите такой значок, попробуйте задержать над ним курсор мыши, чтобы узнать, 
какая ошибка была совершена при выполнении описанных выше шагов.

4. Чтобы проверить назначение двух портов (по одному для каждого размещенного 
в топологии вывода), нажмите Ports (Порты) в окне настройки электромагнитной 
симуляции, как показано ниже.

5. Нажмите Frequency Plan (План свипирования частот) и установите параметр Sweep 
Type (Режим свипирования частоты) в Adaptive (Адаптивный), Fstart=3 GHz, Fstop=7 GHz и 
Npts=101.

Рис. 57.

Рис. 58.

Примечание:
 – Adaptive (Адаптивный) – предпочтительный режим свипирования частоты 

при электромагнитной симуляции (в отличие от Linear (Линейный), который 
является предпочтительным при схемотехнической симуляции.

 – Вы можете добавлять дополнительные диапазоны, нажимая кнопку Add 
(Добавить).
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7. Нажмите Options (Опции), перейдите на вкладку Mesh (Сетка), установите флажок 
Edge Mesh (Дополнительное разбиение сетки в области краев) и оставьте остальные 
поля в их состоянии по умолчанию.

Рис. 59.
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9. Это действие вызовет появление двух всплывающих окон: Job Manager (Управление 
заданиями) и Momentum Simulation Status (Состояние симуляции Momentum), как 
показано ниже:

 –  Окно Job Manager (Управление заданиями): в нем отображается состояние задания 
симуляции. После завершения симуляции состояние в этом окне меняется на Done 
(Выполнено).

8. Мы завершили настройку электромагнитной симуляции. Нажмите кнопку Save 
(Сохранить) и кнопку Simulate (Симулировать) в нижнем правом углу окна настройки 
электромагнитной симуляции.

Рис. 60.

Рис. 61.
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 – Окно Momentum Simulation Status (Состояние симуляции Momentum): в нем 
отображается состояние симуляции. В этом окне показывается время завершения 
симуляции, а также точки частоты, потребовавшиеся для достижения сходимости 
результатов при выполняемом нами свипировании частоты – например, 15 точек 
частоты в рассматриваемом нами примере. Это произошло, так как мы выбрали 
адаптивный (Adaptive) режим свипирования частоты, и симуляция автоматически 
останавливается при достижении сходимости результатов.

Рис. 62.
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10. Дисплей данных симуляции Momentum откроется автоматически. Удалите все 
графики, вставьте новый график в прямоугольной системе координат и выберите 
для показа при соответствующем запросе параметры S(1,1) и S(2,1) в дБ (dB).

Рис. 63.

Примечание:
При выполнении адаптивного свипирования частоты система ADS генерирует 
два файла с наборами данных: один для точек, в которых проводится симуляция 
(в нашем случае это 15 точек частоты), второй, с добавлением в конце “_a” – 
отражающий отображаемую на графике адаптивную аппроксимированную 
полиномом рациональную кривую. Для целей визуализации данных рекомендуется 
использовать набор данных с добавлением в конце “_a”.

Рис. 64.
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Шаг 4 – Сравнение результатов электромагнитной и 
схемотехнической симуляции
Последняя задача – сравнить результаты электромагнитной и схемотехнической 
симуляции. Чтобы просмотреть оба результата на одном графике, два раза нажмите на 
график Momentum и нажмите на раскрывающийся список, чтобы найти набор данных 
для схемы. Он должен иметь одинаковое с ячейкой имя (например, Lab4_Mstrip_Filter). 
Выберите для отображения параметры S(1,1) и S(2,1) в дБ (dB). Просмотрите отклики 
схемотехнической симуляции и симуляции Momentum.

Рис. 66.

Рис. 65.
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Практический пример 2: Разработка и симуляция 
микрополосковой антенны

Теория
Микрополосковая антенна в своей самой простой конфигурации состоит из излучающей 
пластины, располагающейся на одной стороне диэлектрической подложки, при этом на 
второй стороне подложки находится заземляющая плоскость. Проводники излучающей 
пластины обычно изготавливаются из меди или золота, при этом их форма, фактически, 
допускается любой. Тем не менее, чтобы упростить анализ и предсказание эффективности 
антенны, обычно используют традиционные формы. Излучающие элементы и питающие 
линии обычно изготавливаются методами фотолитографии с последующим травлением на 
диэлектрической подложке. Типовая конфигурация микрополосковой антенны показана 
на рисунке ниже.

Излучающая пластина может иметь квадратную, прямоугольную, круглую, эллиптическую 
или любую другую форму. Исходя из простоты изготовления и анализа, наиболее часто 
используются квадратная, прямоугольная и круглая формы пластин. Среди преимуществ 
микрополосковых антенн по сравнению с традиционными антеннами СВЧ-диапазона 
можно выделить:

 – малый вес, небольшой объем;
 – низкую стоимость изготовления;
 – простоту массового производства;
 – возможность реализации линейной и круговой поляризации с помощью простых 

питающих линий;
 – простоту интеграции с ИС СВЧ-диапазона;
 – возможность изготовления питающих линий и согласующих цепей одновременно с 

антенными структурами.

Благодаря простоте разработки и изготовления микрополосковые антенны находят 
широкое применение – от военного до коммерческого. Такие антенны активно 
применяются в изделиях для РЛС с фазированной антенной решеткой, а также в изделиях, 
требующих острой направленности и малого поперечного размера луча.

Цель
Спроектировать микрополосковую антенну на 2,4 ГГц и симулировать ее характеристики, 
используя систему ADS 2011 (или более поздней версии).

Шаг 1 – Расчет размеров микрополосковой антенны
Выберите подходящую для разработки микрополосковой антенны подложку с толщиной 
h и относительной диэлектрической проницаемостью εr. В нашем случае мы будем 
использовать следующий диэлектрик:

a. Высота (Height): 1,6 мм
b. Толщина металла (Metal Thickness): 0,7 mil (1/2 унции меди на кв. фут) = 17,8 мкм
c. Относительная диэлектрическая проницаемость (εr): 4,6
d. Тангенс угла потерь (TanD): 0,001
e. Удельная электропроводность (Conductivity): 5,8·107 См/м

Рис. 67.

Излучающая пластина

Заземляющая 
плоскостьДиэлектрическая 

подложка
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Ширина и длина излучающей поверхности вычисляется по формуле:

W=L=       c       = 29,2 мм
            (2f √ε

r
)

где
 – c = 3·108 м/с – скорость света;
 – f = 2,4 ГГц – частота;
–– ε

r
 = 4,6 – относительная диэлектрическая проницаемость.

Глубина захода питающей линии внутрь изучающей поверхности вычисляется по формуле:
H=0,822·L/2 = 12 мм

Прочие размеры:
 – Y= W/5 = 5,8 мм
 – X = Z = 2W/5 = 11,7 мм

11. Рассчитайте физические параметры микрополосковой антенны, геометрия которой 
представлена на иллюстрации ниже, используя приведенную формулу.

Рис. 68.
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Шаг 2 – Создание геометрии микрополосковой антенны
1. Создайте новую рабочую среду, назовите ее Lab5_PatchAntenna_wrk.
2. Откройте новую топологическую ячейку и назовите ее Patch_Antenna.
3. Используйте команды Insert -> Polygon (Вставить -> Полигон) и Insert -> Coordinate 

Entry (Вставить -> Ввод координат) для ввода координат, чтобы задать требуемые 
для построения геометрии микрополосковой антенны точки согласно проведенным 
вычислениям:

Рис. 69.

Шаг 3 – Симуляция антенны
Подсоедините вывод в точке запитывания антенны, как показано ниже.

Рис. 70.
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4. Перейдите в окно настройки электромагнитной симуляции, нажмите Substrate 
(Подложка) и New (Новый), чтобы принять в качестве шаблона подложку из 
алюмооксидной керамики 25 mil Alumina. Задайте параметры подложки, как 
показано ниже, отредактируйте высоту подложки по умолчанию, значения 
относительной диэлектрической проницаемости, тангенса угла потерь и высоты 
проводников, задав в качестве материала для них Copper (Медь) – выберите его 
из списка Add from Database (Добавить из базы данных). Смена наименования 
диэлектрика – опциональный шаг, не оказывающий влияния на симуляцию.

Рис. 71.

Рис. 72.

Рис. 73.

5. Задайте Simulation Frequency range (Диапазон частот симуляции) от 2.1 GHz до 
2.7 GHz при адаптивном свипировании частоты (Adaptive) и добавьте с помощью 
кнопки Add (Добавить) новую одиночную точку (Single) на частоте 2.4 GHz, как 
показано ниже.

Рис. 74.
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6. Нажмите Simulate (Симулировать) и просмотрите результаты симуляции на дисплее 
данных.

Рис. 75.

Шаг 4 – Диаграмма направленности антенны
1. Для диаграммы направленности антенны в дальней зоне перейдите к команде меню 

EM > Post Processing > Far Field (Электромагнитная симуляция > Постобработка > 
Дальняя зона), выберите желаемую частоту (например, 2,4 ГГц) и нажмите Compute 
(Вычислить).

Рис. 76.
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2. Будет проведен расчет в дальней зоне, результаты которого будут отображены в 
окне постобработки, как показано ниже. Чтобы увидеть все требуемые данные, 
можно использовать команду Window > Tile (Окно > Упорядочить), затем с помощью 
расположенных внизу вкладок перейти к Plot Properties (Свойства графика) и затем 
выбрать Far Field > Antenna Parameters (Дальняя зона > Параметры антенны).

Рис. 77.

3. Перейдите на вкладку Far Field Cut (Срез дальней зоны) и нажмите кнопку Display 
Cut in data display (Показать срез на дисплее данных).

Рис. 78.
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4. По завершении мы получим возможность увидеть срез дальней зоны на 
стандартном дисплее данных, как показано ниже.

Практический пример 3: Совместная электромагнитная/
схемотехническая симуляция

Что представляет собой совместная электромагнитная/
схемотехническая симуляция?
Часто на топологии требуется наличие дискретных компонентов, таких как R, L, C, 
транзисторы, диоды и пр., однако решатели электромагнитной симуляции не могут 
проводить симуляцию таких дискретных компонентов напрямую. По этой причине мы 
используем совместную симуляцию, в рамках которой создаем топологический элемент и 
затем помещаем его в схему для сборки дискретных компонентов.

Типовой процесс совместной электромагнитной/схемотехнической 
симуляции

1. Подсоедините выводы в том месте топологии, где нам необходимо создать 
соединения с дискретными компонентами.

2. Задайте пакет материалов и прочие стандартные настройки электромагнитной 
симуляции, такие как Mesh (Сетка), Simulation Frequency range (Диапазон частот 
симуляции) и пр.

3. Создайте модель электромагнитной симуляции и символ для этого топологического 
элемента.

4. Вставьте этот топологический элемент в схему и подсоедините требуемые 
дискретные компоненты.

5. Настройте соответствующие параметры схемотехнической симуляции.
6. Если это не было сделано ранее, будет выполнена симуляция методом Momentum 

или FEM, в противном случае те же самые данные симуляции будут использованы 
повторно.

Рис. 79.
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Шаг 1 – Создайте топологию, где будет выполняться совместная 
симуляция

1. Создайте топологию вручную или сгенерируйте ее из схемы, пользуясь описаниями 
из предшествующих разделов.

2. Разместите выводы везде, где нам необходимо создать соединения или 
смонтировать дискретные компоненты в рамках топологии.

3. В данном случае мы использовали слой “cond” для проводников и слой “hole” для 
переходных отверстий, чтобы создать соединение с землей.

4. Создайте подложку 25 mil Alumina с параметрами Er = 9.9, TanD = 0.0009 и материалом 
Gold (Золото) для слоя “cond” с удельной электропроводностью 4.1E7 и толщиной 
0.7 mil. Слой “hole”, назначенный в качестве VIA (переходные отверстия), также 
обладает удельной электропроводностью золота, как это показано в графической 
части окна.

Совет:
Чтобы включить переходные отверстия (VIA) в подложку, нажмите правой кнопкой 
мыши на “Alumina” в графической части окна подложки и нажмите мышью Map 
Conductor VIA (Назначить переходные отверстия из проводящего материала).

Рис. 80.

Рис. 81.
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5. Задайте план свипирования частот в соответствии с требованиями для 
схемотехнической симуляции. Например, в нашем случае мы оставим его от 0,01 до 
1 ГГц включающим 101 точку..

Примечание:
Если нам необходимо установить нелинейные компоненты, такие как транзисторы, 
на которые необходимо подавать смещение постоянного тока, то симуляция 
Momentum должна начинаться с 0 Гц, чтобы корректно учитывать постоянную 
составляющую тока.

Рис. 82.
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Шаг 2 –  Создание компонента совместной электромагнитной/
схемотехнической симуляции и символа

1. Для настройки совместной электромагнитной/схемотехнической симуляции 
перейдите к опции Model/Symbol (Модель/Символ) и выберите Create EM Model 
when… (Создать модель электромагнитной симуляции, когда...) и Create Symbol 
when……. (Создать символ, когда...), как показано на снимке экрана.

2. С помощью этих опций будут созданы база данных и символ электромагнитной 
симуляции, которые затем будут использоваться в процессе совместной 
электромагнитной/схемотехнической симуляции.

3. Размер символа можно отрегулировать с помощью задания опций Size -> min 
pinpin distance (Размер -> Минимальное расстояние между выводами), а также 
схемотехнических единиц измерения = 0,1, 0,2 и пр. В данном примере мы зададим 
их равными 0,5, чтобы задать разумный размер символа при его размещении в 
схеме.

4. Если вы желаете выполнить электромагнитную симуляцию совместно 
со схемотехнической, нажмите кнопку Create Now (Создать сейчас) для 
электромагнитной модели и символа или сначала нажмите на иконку Simulate 
(Симулировать), чтобы выполнить симуляцию Momentum – любой из этих способов 
должен привести к правильному результату.

5. Нажмите кнопку Simulate (Симулировать), чтобы начать симуляцию Momentum.

Шаг 3 – Процесс симуляции и генерации базы данных
1. Когда мы выполняем симуляцию Momentum, в окне состояния можно заметить 

предупреждение, подобное приведенному ниже:

2. В данном сообщении просто утверждается, что калибровка не может выполняться 
для портов, размещенных внутри структуры, и обычно мы можем игнорировать 
такие предупреждения.

(Необходимо исправить настройки порта:
Калибровка не будет использоваться для порта “P11” (вывод “P11” не находится на 
границе проводящего и непроводящего региона).)

Рис. 83.
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3. Если необходим особый вид калибровки, это можно сделать с помощью опции Ports 
(Порты) в окне настройки электромагнитной симуляции, как это показано на снимке 
экрана ниже.

Рис. 84.

4. Когда симуляция будет завершена, откроется дисплей данных Momentum, однако на 
него нам не нужно смотреть в данный момент, так как дискретные компоненты еще 
не установлены в топологии. Тем не менее, иногда лучше просмотреть результаты, 
чтобы увидеть, какой вид перекрестных связей наличествует между различными 
областями топологии без установленных компонентов. Иногда мы прекращаем 
дальнейший анализ, обнаружив между областями нежелательную связь, которая 
вызывает ухудшение рабочих характеристик нашего устройства.

5. Просмотрев главное окно системы ADS, мы обнаружим появление видов “emModel” 
и “symbol” под ячейкой, в рамках которой выполняется симуляция. Для совместной 
электромагнитной/схемотехнической симуляции мы используем вид “emModel”.

6. Откройте новую схемотехническую ячейку и перетащите вид emModel из главного 
окна в эту схемотехническую ячейку. Выберите символ топологии, нажмите мышью 
“Choose view for simulation” (Выберите вид для симуляции) и выберите emModel из 
списка, как показано ниже.
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7. Вставьте требуемые дискретные компоненты в схему и подсоедините их к 
топологическому элементу, как показано на снимке экрана ниже.

Рис. 85.

Рис. 86.
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8. Нажмите на иконку Simulate (Симулировать) в редакторе схем и вставьте график в 
прямоугольной системе в дисплее данных, чтобы посмотреть значения параметров 
S(1,1) и S(2,1), как показано ниже.

Рис. 87.

Поздравляем! Вы завершили раздел «Планарная электромагнитная симуляция в ADS». 
Дополнительные примеры вы найдете здесь:
www.Keysight.com/find/eesof-ads-rfmw-examples

http://www.Keysight.com/find/eesof-ads-rfmw-examples
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